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  CHAPTER 2 

II. SHORT ANSWER QUESTIONS: 

 

1. Mouse and keyboard 

2. A scanner is a device which is used to scan a diagram, photograph etc. And the image can be brought on to the 

monitor. A scanner may be in different shapes. It may be handheld or flatbed scanner. 

3.  1) A barcode scan is fast and reliable. 2) Barcodes eliminate the possibility of human error. 

4.  1)CRT ( Cathode Ray Tube) monitors 2) LCD (Liquid Crystal Display) 

5. Dot Matrix Printer is an impact printer which leaves the impression of character in the form of Dots. These 

printers consist of a hammer which prints the characters one by one. 

6. 1) High speed of printing. 2) Excellent Quality of printing. 

7. Drum plotter is a type of pen plotter that wraps the paper around a drum with a pin feed attachment. The 

plotter was the first output device to print graphics and large engineering drawings. 

8. Light pen is pen-shaped light-sensitive device and can be connected to a computer to draw graphics and to 

highlight the text directly on the computer screen. 

9.  The uses of barcodes is to read merchandise in stores which eliminate the possibility of human error and also 

take less time in entering data by hand. 

10. Wireless mouse provides capability of connecting without cables. Whereas optical mouse utilizes LED light 

source and photo technology to detect movement. 

11. Dot Matrix printers are so called because it uses a matrix of dot to print each character. This printer consists of 

hammer which prints the characters one by one. 

12. Joystick is an input device which is used to play games. It is an electric device which is used like a mouse for 

controlling cursor movement. It is used frequently in programs like video games and personal computer. 

 

III. LONG ANSWER QUESTIONS: 

 

1. Input devices are peripherals you can attach to your computers that allows it to receive input from a user. Most 

computers come standard with two universal inputs: the keyboard and the mouse.  

Any devices that output information from a computer is called an output devices. Since information from a 

computer is output in either visual or auditory format, the most common output devices are the monitor and 

speakers. 

2. The types of scanners are: 

i. Flatbed Scanner: It contains a scanner head that moves across a page from top to bottom to read the page 

and converts the image or text of the page into digital form. 

ii. Drum Scanner: A fixed scanner head is used in such type of scanner and the image to be scanned is 

placed across the head. 

iii. Slide Scanner: This type of scanner is used to scan photographic scans directly to produce files 

understandable by computers. 

iv. Handheld Scanner:  It is a scanner that is moved by the end across the page to be scanned. This type of 

scanner is very handy and easy to use.  

3. Following are the types of computers: 

 i) OCR: Optical Character Reader is a scanning device which is used to detect alphabetic and numeric characters 

printed on paper. These characters can be typed or handwritten. When users scan a document it is stored in the 

form of an image. 

ii) OMR: Optical Mark Recognition is a technology of electronically extracting data from the marked fields such 

as checkboxes, ovals and other shapes in printed forms. This technology is used for applications in which large 

numbers of hand-filled forms need to be processed quickly. 



iii) MICR: Magnetic Ink Character Recognition is a special technique of interpretation of a line of characters by a 

computer. These special characters are written on a paper which can be read by the computer. MICR system is 

used in banking applications worldwide. 

4. The types of monitors are: 

i. CTR monitors: A Cathode Ray Tube is basically a vacuum tube containing an electron gun at one end and 

a fluorescent screen at the other end. These electrons travels through a narrow path within the tube with 

high speed using various electro-magnetic devices and finally strike the phosphor points present on the 

fluorescent screen, thus creating an image. 

ii. LCD monitors: Liquid Crystal Display is one of the most advanced technologies available at present. 

Typically, an LCD monitor consists of a layer of color or monochrome pixels arranged between a couple of 

transparent electrodes and two polarizing filters. At present there are two types of LCD technology 

available; active matrix and passive matrix. 

5.  Printer are the output devices which prints in the form of graphics, letters, reports etc.  The data from the main 

memory of computers transferred to the printer and the same is printed. Printers are of two types: 

i. Impact printers: Impact printers use ribbon/ carbon paper to leave the impression on the paper. These are 

the mechanical contact between print head and paper. Dot Matrix, Chain Printer and Daisy Wheel Printer 

come in the category of impact printer. 

ii. Non-impact printer:  In non impact printer there is no mechanical contact between the print head and 

paper are called non- impact printers. These are classified into Laser printer, thermal matrix printer and 

inkjet printer. 

6. Impact printers use ribbon/ carbon paper to leave the impression on the paper. These are the mechanical contact 

between print head and paper. Dot Matrix, Chain Printer and Daisy Wheel Printer come in the category of impact 

printer. 

I. Dot Matrix Printer: Dot Matrix Printer is an impact printer which leaves the impression of character in 

the form of Dots. These printers consist of a hammer which prints the characters one by one. The hammer 

contains 9 pins or 24 pins. 

II. Chain Printer: Ina chain printer, a chain of characters rotates and in this process hammer of the printer 

strikes on chain and the characters of the chain leaves an impression of the character on paper. 

III. Daisy Wheel printer:   It contains a disk of metal or plastic and it has 96 characters on its petals. Typical 

speed of daisy wheel printer is 20 characters per second to 100 characters per second. 

7. Laser printer: Laser printer generates both graphics as well as text as image outputs. The quality of output is very 

good. These printers use the technique of laser and photocopy. It can print more than 300 pages in one minute and 

it can also print multicoloured graphics/ output. 

8. Explain the following: 

1) Microphone: a microphone is a device for converting sound waves into electric energy that has wave 

characteristics similar to those of the sound. All microphones have diaphram which vibrates when the wave’s 

fronts reach to it. It then converts mechanical vibrations into electrical signals. These signals can then be 

amplified, stored, transmitted or processed. 

2) Light pen: Light pen is pen-shaped light-sensitive device and can be connected to a computer to draw graphics 

and to highlight the text directly on the computer screen. When the pen brought close to the screen, the light 

emitted by tit modifies the data. 

3) Track ball: track ball was invented before the invention of mouse. It is a small thumb balls clip onto the side of 

the keyboard and have integral buttons with the same function as mouse buttons. 

4) Digital camera: A digital camera is a camera that captures photographs digitally by recording images via an 

electronic image sensor. It records and stores photographic images in digital form. The digital cameras can do 

what the film cameras cannot. 

9. Digital cameras can display images on a screen immediately after they are recorded, thousands of images on a 

single small memory device, recording video with sounds and deleting images to free storage space which film 

cameras cannot do. : A digital camera is a camera that captures photographs digitally by recording images via an 

electronic image sensor. It records and stores photographic images in digital form. Capture is usually 

accomplished by using photo sensor. The stored image can be uploaded to a computer immediately or stored in the 

camera to be uploaded into a computer or printer later. 

   

 



10. Advantages: 

1) Plotters are able to work on large sheets of paper and still maintain high quality resolution. 

2) It can print text and images together. 

3) Efficiency, reproducibility, accuracy and speed are all attributes of a plotter. 

 Disadvantages: 

1) Plotters take up more space than regular printers. 

2) The price is much higher than the price of printer. 

3) They print very slowly. 

4) More pens are needed for different colour 

  

CHAPTER 3 

 

II. SHORT ANSWER QUESTIONS: 
1. Bit is the smallest unit of storage of memory. 

2.  RAM stands for Random Access Memory. It is the working area that provide user to store data, write programs or 

feed anything into the computer. 

3. ROM stands for Read Only Memory. It is the memory inside the computer that can be used for reading purpose. 

Its content cannot be written or modified. 

4. The type of ROM are: 

1) PROM ( Programmable Read Only Memory) 

2) EPROM(  Erasable Programmable Read Only Memory) 

3) EEPROM(Electrically Erasable Programmable Read Only Memory)  

5. Pen Drive is also known as thumb drive. A pen drive can be put to use immediately as and when needed with no 

batteries, no software and no cables, a pen drive is totally portable. 

6. Magnetic Disc is very useful and one of the most popular storage devices. Disk can be used from both surfaces. 

7. CD-R or Compact Disc- Recorder is a type of compact disc that can be written by a consumer using disc recording 

hardware. Whereas, CD-RW or Compact Disc- Rewritable, is a CD format that provides flexible recording option. 

III. LONG ANSWER QUESTIONS: 

1. The types of primary memory are: 

1) RAM : RAM stands for Random Access Memory. It is the working area that provide user to store data, 

write programs or feed anything into the computer. The content of RAM can be read, written deleted or 

modified by the user. 

2) ROM: ROM stands for Read Only Memory. It is the memory inside the computer that can be used for 

reading purpose. Its content cannot be written or modified. 

2. The units of memory are: 

1) BIT:  A single binary digit is called a bit. It is the smallest unit of storage. A bit can have only two values 1 

or 0. These 1 and 0 values in computer logic are defined as true or false. 

2) NIBBLE: A half of a bit (four bits) is called a nibble. 

3) BYTE: A single bit cannot represent all the information in computer memory. As it can have two different 

values so it can represent only two different values in memory not all values. So bit must be combined into 

groups to represent all the values or characters present or keyboard inside the memory. 

3. Pen drives are also known by the name thumb drive. A pen drive can transfer large volumes of data. Since storage 

capacity of pen drives is very much larger as compared to portable medium like floppy a large volume of data can 

be carried on a single pen drives. 

4. The following are the comparison of CD and Pen Drives:  

1) Pen drive gives you better portability than CD. It comes in capacity of 1, 2, 4, 8, 16, 32 and 64GB. 

Whereas, CD has a capacity of 700MB. 

2) CD is less expensive to purchase, but for a pen drive, you have to pay higher price. 

3) The biggest advantages to use flash drive memory is you can add, erase and modify data in real time over 

and over; most blank CDs let you burn data to them only one time.  

4) CD is prone to scratches whereas a pen drive is not. 

5. RAM stands for Random Access Memory. It is the working area that provide user to store data, write programs or 

feed anything into the computer. The content of RAM can be read, written deleted or modified by the user. 



Whereas, ROM stands for Read Only Memory. It is the memory inside the computer that can be used for reading 

purpose. Its content cannot be written or modified. ROM is used to store system software. 

 

 

CHAPTER 4 

 

II. SHORT ANSWER QUESTIONS: 

1. A computer can do nothing until and unless it gets instructions from the user. So, it requires user’s instruction. The 

set of instructions which helps in performing various operations on computer is called software. 

2. Application software is a program designed to help the user for performing a certain type of work. One application 

program is designed only for one specific application. Graphic software is a program or collection of programs 

that enable a person to manipulate or models in a computer. 

3. A graphic software is a general application software that is used for editing photos and provide filters, effects etc 

and make the layers of the image, photographic more attractive. 

4. Window 7, Mac oS and Linux are the example of system software. 

5. Microsoft Office, Adobe Photoshop and Google are the example of application software. 

6. The purpose of utility software is that it helps to manage the computer hardware, operating system or application 

software by performing a single task or a range of tasks. 

7. The three example of spreadsheet programs are Gnumeric, KSpread and MS Excel. 

8. In assembly language, Mnemonic codes were used in place of binary codes. Mnemonic codes are short words 

representing the whole instruction. For example; TRAN for transaction, ADD for addition, SUB for submission, 

MUL for multiplication etc. 

III. LONG ANSWER QUESTIONS: 

1. The two specific purpose application are: 

1) Billing and Accounting Management software: It gives a simple, efficient and cost- effective way to 

gain full control over accounting process. This software may have embedded simple and reliable booking 

utility. It may be useful for a small business organisation to meet the enact needs of business in most cost 

effective way. 

2) Reservation software: It is use to reserve the seat in different types of services like railways, airways, 

hotel/motel etc. Using the reservation software, the work of reservation is minimized on the  part of the 

computer operation and it also become easy for the travellers or customers to get seat/ticket reserved. 

2.  

Application software System software 

1) Software that is designed and written for a 

specific personal, organizational or processing 

task such as graphic software. 

2) This includes database programs, word 

processors and spreadsheets. 

3) Sits on top of systems software because it is 

unable to run without the operating systems and 

system utilities. 

1) It consists of low – level programs that interact 

with the computer at a very basic level. 

 

2) This includes operating system, compilers and 

utilities for managing computer resource. 

3) It runs by its own without the help of 

application software. 

3. File backup utilities are very important for protecting the working environment from any disaster. Files being 

generated and written on your computer are to be stored for future use in form of backup. In case the computer 

system is damaged, there is an alternate ways of taking such backup files on other computers so that the work is 

not hampered. 

4. Write the notes on: 

i. Low Level Language: Low Level Language is also known as machine language. A computer program 

written in low level language on one computer is specifically for that machine where it has been written. 

ii. Assembly Language: In Assembly language, Mnemonic language was used in place of binary codes. The 

program may be written in High Level Language. For example; TRAN for translation.  

iii. Interpreter: An Interpreter is a computer program which converts instructions, line by line, written in 

High Level Language into machine language. 

iv. Compilers: A compilers is a computer program which converts the program written in the High Level 

Language into machine language. 



5. Utility software is a computer software designed to help manage computer hardware, operating software or 

application software by performing system a single task or a small range of tasks. Some utility software program 

are integrated into most major operating system. Example: 1) Disk storage utilities 2) Anti- virus utilities scan for 

computer virus 3) Cryptographic utilities encrypt and decrypt files. 

6. Presentation software is a software package. The purpose of it is to monitor or screen in the form of a slide show. 

Example; MS PowerPoint, Magic Point, Coral presentation and opera show format. 

7. School Inventory management software used for student records, fee management account, employed management 

and stock management.  

IV. APPLICATION BASED QUESTIONS: 

I. An Operating system is the system software that managed computer and software resources and provides common 

services for computer program. Operating software ensures that all parts of the computer are properly functioning. 

It controls all the functions being performed in the hard disk and text computer command for instruction given to 

the computer. 

 

CHAPTER 5 

 

II. ANSWER THE FOLLOWING QUESTIONS: 

1. Operating software is a set of system programs or commands that acts as an interface between user or 

computer hardware. 

2. A multi- user operating system allows for multiple users to use the same computer at the same time and 

different time. 

3. Multi tasking means working in different programs in the same time. 

4. a) UNIX: UNIX is a computer operating system used most commonly in servers and workstations.  

b) LINUX: LINUX is a Unix-like operating system that was designed to provide personal computer users a 

free or very low- cost operating system comparing to traditional and usually more expensive Unix system. 

5. Real Time Operating system is used where response is needed quickly without any delay. Robots functioning 

are an example of real- time operating system. Whereas, Real Time Operating system is used where response 

is needed quickly without any delay. Robots functioning are an example of real- time operating system. 

Whereas, Distributed Operating System is used in networking where computers are connected and there is 

need to share resources like printing, memory files, data etc. 

6. The three operating system are: 

1) Multi- user Operating system: A multi- user operating system allows for multiple users to use the same 

computer at the same time and different time. Example; Linux, Unix and window 2000. 

2) Real Time Operating System: Real Time Operating system is used where response is needed quickly 

without any delay. Robots functioning are an example of real- time operating system.  

3) Distributed Operating System: Real Time Operating system is used where response is needed quickly 

without any delay. Robots functioning are an example of real- time operating system. Whereas, Distributed 

Operating System is used in networking where computers are connected and there is need to share resources 

like printing, memory files, data etc. 

7. The operating system decides which file will be stored at which location in the memory. Both primary memory 

and secondary memory work under the control of operating system. Thus, operating system work as a memory 

manager. 

III. LONG ANSWER QUESTION: 

 

1. The function of Input and Output system are: 

i. Input/output Management:  The operating system manages the working of different input/ output devices 

attached to the computer. Different input/output devices like printer and scanner work under control of the 

operating system. 

ii. Memory Management: Memory is one of the most crucial jobs operating system. The operating system 

decides which file will be stored at which location in the memory. Both primary memory and secondary 

memory work under the control of operating system.  

iii. Process Management: In operating system, allowing multiple applications to run simultaneously, the 

operating system keeps track of number of processes waiting to get processed and managed the processing 

of each and every process by providing them whatever they have. 



iv. File Management: File management allows all file to be easily changed and modified through the use of 

text editors or some other files manipulations routines. 

v. It determines and maintains the order in which jobs are to be executed in the computer system. 

vi. Automatic transition from job to job as directed by special control statements. 

vii. Interpretation of commands and instructions. 

viii. Coordination and assignment of compilers, assemblers, utility programs and other software to the various 

user of the computer system. 

2. BOSS stands for Bharat Operating System Solution. It is the Linux distribution based on DebianLinux and is 

customised for high performance. Like any other versions of Linux, it is free and is open source having licence in 

public domain. Currently BOSS GNU/Linux is available in all the official Indian languages. 

3. The commonly used operating system are as follows: 

1. Disk Operating System: Operating system is a set of computer program which is also known as Disk 

Operating System. The main function of DOS is to manage disk files.  

2. Windows: Window is a personal computer operating system from Microsoft. Windows contains built in 

networking, which allows users to share files and applications. Window is supported by Microsoft, the 

largest software company in the world. 

3. UNIX: UNIX is a computer operating system used most commonly in servers and workstations. Unix was 

originally released by Bell Labs to various government and educational institutions. 

4.  LINUX: LINUX is a Unix-like operating system that was designed to provide personal computer users a 

free or very low- cost operating system comparing to traditional and usually more expensive Unix system. 

5. Solaris:  Solaris is a unique based operating system developed by Sun Microsystems. This operating 

system is more secure and reliable as Solaris Security Toolkit provides protection settings for Solaris. 

6. BOSS: BOSS stands for Bharat Operating System Solution. It is the Linux distribution based on 

DebianLinux and is customised for high performance. Like any other versions of Linux, it is free and is 

open source having licence in public domain. Currently BOSS GNU/Linux is available in all the official 

Indian languages. 

4. The type of operating system are: 

i. Single – user operating system: Mostly the computers are used by individuals at a time. These computers 

are stand alone in nature. The operating system running on these computers is called single- user operating 

system. 

ii. GUI: Short for Graphic User Interface, a GUI Operating System contains graphics and icons and is 

commonly navigated by using a computer mouse. 

iii. Multi- user Operating system: A multi operating system allows for multiple users to use the same 

computer at the same time and/or different times. 

iv. Real- Time operating system: : Real Time Operating system is used where response is needed quickly 

without any delay. Robots functioning are an example of real- time operating system. 

v. Distributed Operating System: Real Time Operating system is used where response is needed quickly 

without any delay. Robots functioning are an example of real- time operating system. Whereas, Distributed 

Operating System is used in networking where computers are connected and there is need to share 

resources like printing, memory files, data etc. 

vi. Multi processing Operating system:  An operating system capable of supporting and utilizing more than 

one computer processor.  

i. Multi tasking operating system: An operating system that is capable of allowing multi software processes 

to run at the same time. 

ii. Multithreading Operating system: Operating system that allows different parts of a software program to 

run concurrently.  

5. Mostly the computers are used by individuals at a time. These computers are stand alone in nature. The 

operating system running on these computers is called single-user operating system. Whereas, a multi 

operating system allows for multiple users to use the same computer at the same time and/or different 

times. 

6. In operating system, allowing multiple applications to run simultaneously, the operating system keep tract 

of the number of processes waiting to get processed and manages the processing of each and every process 

by providing them whatever they want. The modern operating systems allocate a part of main memory to 

each running application. 



 

 

CHAPTER 6 

 

II. ANSWER THE FOLLOWING QUESTIONS: 

1. When your computer starts for the first time, what you see is the desktop. It is split into two areas: the strip at the 

bottom with the clock to the right and the round start bottom to the left is called the taskbar. 

2. When a window is active (its taskbar button appears pressed down), clicking its taskbar button minimizes the 

window. That means that the window disappears from the desktop. Minimize a window does not close it or delete 

its content- it merely removes from the desktop temporarily. 

3.  Recycle bin is like a dustbin used for storing deleted items. When you delete some files or folder, it first goes to 

the recycle bin. These deleted items can be restored later on providing the recycle bin is not made empty. The 

recycle bin can be changed according to the requirement. 

4. To the right of the start button, there are some icons on the taskbar; these icons are generally of internet explorer, 

Outlook express, show desktop and show channels. 

5. Control panel is a component of MS Window that provides the ability to view and control changes to nearly every 

aspects of Windows. 

6. The features of window 7 are: 

1) It is easy to work in Window 7. 

2) It is very fast and safe operating system. 

3) It is used to play games, listen music, view pictures and for a lot more entertainment. 

4) It provides multi tasking environment. 

5) It provides global connectivity through internet. 

6) It provides personalized environment on the computer. 

7) It forms the platform for running other software programs in the computer. 

7. A shortcut is a link to an item on your computer. You can create shortcut and place them in a convenient location.  

8. Calculator can be open by clicking on start> All program> Accessories>calculator. 

9. Pointing means moving the mouse so that the mouse pointer is positioned on what you want to point to. Whereas, 

clicking means to point at something. Press the primary mouse button down and then release it. This is called 

clicking. 

10. Shift key + Delete. 

 

III. LONG ANSWER QUESTIONS: 

 

1. The function of the control panel are as follows: 

1) Keyboard function 

2) Mouse function 

3) Network setting 

4) Power management 

5) Desktop settings 

6) Sound and video settings 

7) Program installation 

8) Hardware controls etc. 

2. To recover the deleted file from the recycle bin : 

i. Open the recycle bin by double clicking the recycle bin on the desktop. 

ii. To restore a file, click it and then, on the toolbar, click restores this item. The file will be restoring to the 

original place. 

3. To create folder: 

1) Start windows 

2) The desktop appears on the screen. Double click the computer icon present on the desktop. 

3) Double click on the icon of local disk (C:). You will see various files and folders. 

4) Right click the mouse at some empty area. You will see a popup menu. 

5) Click New option in the popup menu. 

6) Click Folder option in the sub menu. A new folder named New Folder will be created. 



4. The procedure for moving files: 

i. Start by opening the folder that contains the file or folder you want to move. 

ii. Open the folder where you want to move it in a different window. 

iii. Position the window side by side on the desktop so that you can see the contents of both. 

iv.  Drag the files or folder from the first folder to the second folder. 

              The procedure for copying files: 

 i.  Right click the file or folder you want to copy. Shortcut menu appears. 

 ii. Select copy in the shortcut menu to copy the file or folder. 

 iii.  Right click on the required area where you want to move or copy and select paste option in the shortcut 

menu. 

5. Explain the following: 

a)  Notepad: 

Notepad is a basic text- editing program and it is most commonly used to view or edit text files. Notepad is a plain 

text- editor in which you can type the work in a single font type and font size.  

b) WordPad: 
WordPad is very useful for basic word processing. WordPad is a text- editing program you can use to create and 

edit documents. WordPad includes rich formatting and graphics. 

c) Paint: Paint is a feature in window that you can use to draw, colour and edit pictures. You can use paint like a 

digital sketchpad to make simple pictures, creative projects or add text and design to the other pictures. 

d) Calculator:  Calculator is used to perform simple calculations such as addition, subtraction, multiplication and 

division. 

6. To set system date and time: 

1) Double-click the System Time in the System Tray. Check whether the clock is giving the right time. If 

there is any difference, change the system time to the current time. 

2) Similarly check the System Date. If there is any difference, change the system date to the current date. 

3) Also apply the correct Time Zone to your computer by clicking the Time Zone tab in the Date and Time 

Properties dialog box. 

7. To create a shortcut: 

1) Open the location containing the items that you want to create a shortcut to. 

2) Right click the item and then click Create Shortcut. The new shortcut appears in the same location as 

the original item. 

3) Drag the new shortcut to the desired location. 

  To delete a shortcut: 

1) Right click the shortcut that you want to delete, click Delete and then click Yes. If you are asked for an 

administrator password or confirmation, type the password. 

 

CHAPTER 7 

 

II. SHORT ANSWER QUESTIONS: 

1. A word processor enables you to create a document, store it electrically on a disk, display it on a screen, modify it 

by entering commands and characters from the keyboard and print on a printer. 

2. Ms Word can be started in the following manner: 

i) Through Desktop: select the icon of Microsoft Office Word and double click the icon. 

ii) Through start (all program) menu: Click Start> All programs> Microsoft Office 2010> Microsoft Word 2010. 

3. Document area is the large area where we type. The vertical bar is called the insertion point and it represents the 

location where text will appear when you type. 

4. Editing is the process in which we make corrections in the document and make some new changes to give better 

presentation of the text. 

5. Select text is one of the important skills required while editing a word document. There are two ways to select 

text: Using mouse and using keyboard. 

6. Undo is used to undo the last action or actions that you made and redo commands is used to redo action Undo 

commands that you undid. 

7. To insert text in a document: 

i) Place the cursor at the position where you want to insert the text. 



ii) Now type the text to be inserted. 

8. Save is used to save with the same name whereas Save As is used to save with different name. 

9. Dragging means placing the text to a location where you want it to appear. 

10. Delete means deleting the wrong words or characters whereas Cut means cutting the selected words or characters 

and paste it to a location where you want. 

 

III. LONG ANSWER QUESTIONS: 

 

1. A word processor enables you to create a document, store it electrically on a disk, display it on a screen, modify it 

by entering commands and characters from the keyboard and print on a printer. The features are as follows: 

i) Insert text: Allows you to insert text anywhere in the document. 

ii) Delete text: Allows you to eras characters, words, lines, or pages as easily as you can cross them out on paper. 

iii) Cut and paste: Allows you to remove a section of text from one place in a document and insert it somewhere 

else. 

iv) Page size and margins: Allows you to define various page sizes and margin and the word processor will 

automatically readjust the text so that it fits. 

v) Search and replace: Allows you to direct the word processor to search for a particular word or phrase and 

replace it. 

Vi) Word wrap: The word processor automatically moves to the next line when you have filled one line with text 

and it will readjust text if you change the margins. 

vii) Print: Allows you to send a document to a printer to get a hardcopy. 

2. Define the following: 

i) Title bar: This is the top bar at the MS-word window. It identifies the word program running and the name of 

the active document. 

ii) Ribbon: Ribbon is located just below the title bar. Ribbons contain two parts; Tabs and groups. Each tab 

contains a set of commands under the group. 

iii) Status bar: It tells information about the document and provides shortcuts for changing view and the zoom. 

iv) Scroll bars: Scroll bars are used when the size of window is larger than the size of screen. 

3. COPYING TEXT: 

i) Using Mouse Right-click:  If right click on the selected text, it will display copy option, just click this option to 

copy the selected content in clipboard. 

ii) Using Ribbon copy button: After selecting a text, you can use copy button available at the ribbon to copy the 

selected content in clipboard. 

iii) Using Ctrl+ C keys: After selecting the text, just press Ctrl+ C keys to copy the selected content. 

PASTING TEXT: 

i)  Position the cursor at the point where you want to paste the text. 

ii) Click paste button present in the Home tab or you can also use Ctrl+ V keys for pasting the text. 

iii) The copied or cut text will appear at the new position. 

4. To print a document in MS Word: 

i) Click the File tab displaying the backstage view. 

ii) Click the print tab to print a document, change print- related settings and to automatically display a preview of 

your document. 

iii) Under printer drop-down, you can select available printers. 

iv) Settings drop-down display the status features. 

V) After you have done all your settings, click print button. 

5.   

Keyboard shortcuts Result 

Ctrl+ Home Moves the cursor to the top of the document. 

Ctrl + End Moves the cursor to the end of the document. 

Home Moves the cursor to the beginning of the 

document. 

End Moves the cursor to the end of the line. 

Ctrl+ Left Arrow Moves the cursor  one word to the left 

Ctrl+ Right  Arrow Moves the cursor one word to the right. 



Ctrl + Up Arrow Moves the cursor to the top of the current 

paragraph. 

Ctrl + Down Arrow Moves the cursor to the button of the current 

paragraph. 
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II. SHORT ANSWER QUESTIONS: 

1. Formatting means to change the appearance of the document to make attractive and readable. It makes document 

more appealing and presentable. 

2. Steps to highlight text: 

i) From Home tab, click Text Highlight color drop down arrow. The Highlight color menu appears. 

ii) Select the desire Highlight color. 

iii) Select the text you wish to modify. It will then be highlighted. 

3. Subscript is positions slightly lower than the text whereas Superscript is positions slightly higher than the text. 

Shortcut for Subscript:  Ctrl + Shift = 

Short cut for superscript: Ctrl + = 

4. Right alignment aligns all the selected text to the right margin. 

5. Toggle case converts the letter to mixed case ie., combination of upper and lower letters. 

6. By default, paragraphs are followed by a blank line and headings have extra space above them. 

i) Select the paragraph before or after which you want to change the spacing. 

ii) On the page layout tab, in the paragraph group, under spacing, click the arrow next to Before or After and enter 

the amount of the space that you want. 

7. By default the orientation is portrait. We can change the orientation by: 

i) Clicking on the page layout tab, in the page setup group, c lick on orientation. 

ii) Select portrait or landscapes form the drop-down. 

8. Headers are printed on top of the page of the document. It includes information as title, name, chapter name etc. 

Footers are printed on bottom of the page of the document. It displays copyright information, page numbers etc. 

9. To insert page numbers: 

i) Go to insert tab, in the Header & Footer group and click page number. 

ii) Click the page number location where you want. 

iii) In the gallery, scroll through the option and then click the page number format that you want. 

iv) To turn to the body of the document, click Close Header & Footer on the design tab. 

10. Format painter is used to apply text formatting and some basic graphics formatting, such a borders and fills. 

Format painter is available under Home tab. 

III. LONG ANSWER QUESTIONS: 

1. Paragraph alignment are of four types: 

i) Align text left: Align all the selected text to the left margin. 

ii) Centre: Aligns text an equal distance to the right margin. 

iii) Justify: Justify text is equal on both sides and lines up equally to the right and left margins many newspapers 

and magazines use full-justification. 

2. Steps to add bullets and numbering to list: 

i) Position the cursor where you want to add bullets or numbers. 

ii) On the Home tab in the Ribbon, click the number list/ bullet list button. If successful, a bullet/ numbers appear. 

Type the text and press enter to start the next bullet/ number. To end the bullet / number list, press enter twice.  

3. To insert page number: 

I) Go to insert tab, in the Header & Footer group, click page number. 

ii) Click the page number location where you want. 

iii) In the gallery, scroll through the option and then click the page number format that you want. 

iv) To turn to the body of the document, click Close Header & Footer on the design tab. 

4. Superscript and subscript refer to numbers that are positioned slightly higher or slightly lower than the text on the 

line. 



To make text superscript, go to Home Tab in the Font group and click superscript. Keyboard Short cut for 

superscript: Ctrl + = 

To make text subscript, go to Home Tab in the Font group and click subscript. Keyboard Short cut for superscript: 

Ctrl + Shift = 

5. Headers are printed on top of the page of the document. It includes information as title, name, chapter name etc. 

Footers are printed on bottom of the page of the document. It displays copyright information, page numbers etc. 

You can insert Header and Footer at every page or selected page.  

The steps to insert Header and Footer are as follows: 

i) On the insert tab, in the Header and Footer group, click Header and Footer. 

i) Click the Header and Footer that you want to add to your document. To turn to the body of your document, click 

close Header and Footer on the design tab (under Header and Footer tools). 
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II. SHORT ANSWER QUESTIONS: 

1. Thesaurus is use to make improvement in words. Using thesaurus, you can change a word with any of its 

synonyms which can prevent repetition of single word in a document. 

2. WordArt is a decorative text that you can add to a document. You can make changes to WordArt, such as the 

font size and the text colour by using the drawing tools. 

3. The type of files that can  be inserted in MSWord: 

i. Auto CAD (.DCX) 

ii. CorelDraw ( .CGM) 

iii. Paint Files (.BMP,.PCX,.GIF,.JPG) 

iv. Lotus 1-2-3 (.PIC) 

v. Computer Graphics Metafiles (.CGM) 

vi. Windows Metafiles (.WMF) etc. 

4. To insert pictures from another files: 

i. Click picture command under Illustrations group. Insert picture dialog box opens. Select  

ii. Select the picture from desired folder and click insert button. 

iii. The selected picture will be inserted in your document. 

5. To insert shape in the document: 

i. Click insert tab, in the Illustrations group, click shapes. 

ii. Right click the shape that you want to add and then click Lock Drawing Mode. 

iii. Click anywhere in the document and then drag to place the shape.  

iv. After you add all the shapes that you want, press Esc key. 

v.  

III.  LONG ANSWER QUESTIONS: 

1. To find a particular words and replace it with required word, follow the steps: 

i. On the Home tab, in the editing group, click Find. The navigation pane open. 

ii. In the search document box, type document or browse through all the results by clicking the Next 

Search result and previous Search Result arrows. 

To replace the text: 

i. On the Home tab, in the editing group, click Replace. In the find what box, type the text that you want 

to search for and replace. 

ii. Click Find next and replace the highlighted text and click replace. 

iii. To skip this instance of the text and proceed to the next instance, click Find next. 

2. The steps to insert WordArt in the document are: 

i. Click where you want to insert decorative text in a document. 

ii. On the insert tab, in the Text group, click WordArt. 

iii. Click any word art style. 

iv. Select the font of your choice from the Edit Word Art dialog box. 

v. Type your name. 

vi. Click Ok button. 

3. To Insert Clip Art in a document: 



i. On the insert tab, in the illustrations group, click Clip art. 

ii. In the clipart task pane, in the Search for text box, type a word or phrase that describes the clip art that 

you want or type in all or some of the file name of the clip art. 

4. To apply spelling check in a document: 

i. Click the Review tab and the click Spelling & Grammar check button. 

ii. A  Spelling & Grammar dialog box will appear and will display wrong spellings or grammar and 

correct suggestions. 

iii. Select one of the given suggestions you want to use and click change option to fix all the spelling or 

grammar mistakes. 

iv. MS-Word displays a dialog box when it finishes checking for the Spelling & Grammar mistakes, 

finally Click Ok. 

v.  
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II. SHORT ANSWER QUESTIONS: 

1. Rows are the horizontal lines and columns are the vertical lines. 

2. To move in a table, you can use mouse, arrow (    ,      ,    ,       ) Keys, tab key or shift + tab keys. 

3. To change the width of a column to a rough estimate is very simple. Place the mouse pointer on the column 

boundary. The pointer takes                 shape. 

Drag the boundary until the column is desired width. 

4. Merge cell option under layout is used to merge cell in a table. 

5. There are two ways to delete a table: 

1) Delete the entire table. 

i. In Print Layout view, rest the pointer on the table until the table move handle appears and 

then click the table move handle. 

ii. Press backspace key. 

2) Delete contents of a table. 

i. Select the contents that you want to clear. 

ii. Press delete key. 

 

IV. LONG ANSWER QUESTIONS: 

1. To insert a table follow the steps given below: 

i. Click where you want to insert a table. 

ii. On the insert tab, in the tables group, click Table, and then insert Table. Insert table dialog box appears 

on the screen. 

iii. Specify the numbers of columns and numbers of rows you want to have in your table. 

iv. Enter a fixed column width or leave the column width field set to Auto. 

v. Click ok to close the dialog box. 

2. For inserting rows and columns follow the steps given below: 

 Add Rows to Above or Below. 

i. Right click in a cell above or below where you want to add a row. 

ii. On the shortcut menu, point to insert and then click Insert Row Above or Insert Rows Below 

option. 

 Add columns to Left and Right. 

i. Right click in a cell left or to the right where you want to add a column. 

ii. On the shortcut menu, point to insert, and then click Insert column to the left or Insert column to 

the right. 

3. To delete a column: 

i. Select the column that you want to delete by clicking the column’s top gridline. 

ii. Right click the mouse and then click Delete Columns option on the shortcut menu. 

4. To perform calculation in a table, we can use formulas in cells. 

Adding a formula 

i. Click in a cell that should contain the sum of rows. 



ii. Click the layout tab and then click Formula button under Data group. You will see a Formula dialog 

box.  

The formula dialog box suggests a default formula which is = SUM (LEFT). 

Now click ok to apply formula and you will notice that left cells have been added and its sum has been 

put in the Total cell. 

5. Alignment in the table means to adjust the symmetry of text or objects in the table. Text can be positioned in 

the cells and alignment of the text can also be changed. 

i. Apply Row and Column alignment using Table Properties option. 

ii. The table properties will appear. 

iii. Right click the mouse within the table. 

iv. The table properties provide several options. You can select suitable width for a particular column and 

height of row (s). 

6. Merging of cells means combining two or more cells in the same row or columns into a single cell. Whereas. 

Splitting of cell means to break a cell into smaller cells. 
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II. SHORT ANSWER QUESTIONS: 

1. Mail merge is a feature with data processing applications that enable the users to send similar letter or 

document to multiple recipients. Mail merge combines a main document with a data source. 

2. The main document contains the text and graphics that are the same for each version of the merged document. 

3. Data source is usually a mailing or address list of names- a database. A data source can be merged with several 

different main documents to produce letters, mailing and envelopes. 

4. The benefits of mail merge are as follows: 

i. Easy to make a change to a single letter and for that change will occur in every letter. 

ii. Once the merge has been set up, thousands of letters can be produced very quickly and automatically. 

iii.  Much easier to read proof. 

iv. A standard letter can be saved and reused. 

5. To set up main document: 

i. Go to mailing tab, in the Start Mail Marge group, click Start Mail Merge. 

ii. Click letters. 

6.  To preview mail merge: 

i. Click Preview results under Mailings. 

ii. Page through each merged document by using the next record and d preview record buttons in the 

Preview Results group. 

iii. Preview a specific document by clicking Find Recipients. 

7. Microsoft Word. 

 

III. LONG ANSWER QUESTIONS: 

1. The mail merge process involves the following steps: 

i. Set up the main document:  The main document contains the text and graphics that are the same for 

each version of the merged document. 

ii. Connect a document to a data source: A data source is a file that contains the information to be 

merged into a document. 

iii. Refine the list o f recipients or items: MS word generates a copy of the main document for each 

recipients or items in your data files. 

iv. Add placeholder, called mail merge fields, to the document: When you perform the mail merge, the 

mail merge fields are filled with information from your data file. 

v. Preview and complete the merge: You can preview each copy of the document before you print the 

whole set. 

2. To connect the document to a data source the file that contains the information need to be merged into a 

document. For e.g., the name and address of the recipients of a letter. 

3. The steps to  print the merged document, follow the steps given below: 

i. On the Mailing Tab, in the Finished Group, click Finish & Merge and then click Print Documents. 



ii. Choose whether to print the whole set of documents, only to copy that is visible, or a subset of the set, 

which you specify by record number. 

4. To edit an existing recipient list we can go to Mailing tab, in the Start Mail merge group and follow the steps:: 

i. Select individual records: Select the check boxes next to the recipients you want to include and clear 

the checkboxes next to the recipients you want to exclude. 

ii. Sort records: Click the column heading of the item that you want to sort by. The list sort is ascending 

alphabetical order. Click the column heading again to sort the list in descending order. 

iii. Filter records:  This is useful if the list contains records that you know you do not want see or include 

in the merge.  

 

 ***************** 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


